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Date Revised Changes Made 

7 June 2013 
Added  one new feature regarding the ability to set hardware vertical 
offset timing. Also added some fixes to the “Software Changes for AMG 
v1.2.1 (Dekov6.2.2)” section. 

12 April 2013 Added Known Limitations and Hardware and Software changes for v1.2. 
Cleaned up Compatibility and Installation sections. 

28 September 2012 Added a last minute fix to the “All other changes” topic. 

06 September 2012 Added Known Limitations and Hardware and Software changes for v1.1.  

Important Information 
Avid recommends that you read all the information in this ReadMe file thoroughly before installing or 
using any new software release. 

Note: Search the Avid Knowledge Base (http://www.avid.com/onlinesupport) for the most up-to-date 
ReadMe file, which contains the latest information that might have become available after the 
documentation was published. 

This document describes compatibility issues with previous releases, hardware and software requirements, 
software installation instructions, and summary information on system and memory requirements, when 
applicable. This document also lists any hardware and/or software limitations. 

http://www.avid.com/onlinesupport
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 Compatibility Notes 
Caution:  Verify your system is using the correct AJA Kona 3G Quad driver.   

Go to Programs and Features within Windows Control Panel and verify the AJA SDK version is 
10.2.1.19.  If it’s not, you can update your ‘Aja driver’ from the AJA Quad directory on the 
software image.  Contact Customer Success with any questions.   

Version Compatibility Matrix 
Avid Motion Graphics Server v1.2.1 

Deko 

Deko  v6.2.2 

PostDeko V8.6 

DekoSelect V3.15 

NRCS 

iNEWS v3.2 

iNEWS Command v2.10.3 or later 

ENPS v6.0 

Unsupported Features 
The following features are not supported in Avid Motion Graphics v1.2.1: 

• Deko3D 
• DekoObjex 
• Dual Program 
• Embedded audio in Video Input 
• VITC, VBI and Dolby pass-through from Video Input 
• Clip Servers (ThunderNet, etc.) 
• Clip Record 
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Third Party Compatibility 

Avid AMG v1.2 Image Rev3.0  
The AMG system drive image Rev.3 is needed prior to upgrading. To verify your system drive was 
configured with this image, navigate to C:\image.txt. Open this text file and verify the following statement 
at the top of the text file: 

AMG 

Rev. 3 

04/25/2012 

If your system shows Rev.1 or Rev.2 you must contact Avid Customer Success for an updated image prior 
to installing the new AMG software.  

Microsoft Hotfix Requirement 
A Microsoft Hotfix is required in order to avoid a system crash that has been happening sporadically. See 
http://support.microsoft.com/kb/2584454. This hotfix is in the current AMG drive image.  

AMG Driver Requirements 
This version of the software requires that you update the AJA driver and Nvidia driver using the 
AMG_Driver_Updater.exe located on the USB software installer.  

To update the AJA driver, do the following: 

1. Navigate to the AMG_Driver_Updater folder, open it, and select the AMG Driver Updater 
executable.  

The system will verify the correct drivers are installed and give you a green check mark if they are 
up to date. If your drivers need to be updated you will see a red check mark. 

2. (Option) If you have a red check mark, select AJA or nVidia to update the appropriate drivers 
automatically.  

ODBC Database 
Oracle 9i and 10g versions on Windows 7 64 bit requires a fix from Oracle.  For more details, go to: 
https://www-304.ibm.com/support/docview.wss?uid=swg21367951.  

KVM Extender 
It is recommended that you first connect the Keyboard, Mouse and VGA directly to the AMG system prior 
to connecting a KVM extender.  After the basic setup has been completed you can connect the VGA 
monitor, Mouse, and Keyboard to the recommended Avocent®  KVM extender.  For more information on 
the models of KVM’s support please check the Avid knowledge database.   

Keyboard, Monitor, and Mouse 
An industry standard USB keyboard, USB mouse and VGA monitor are use to access the Avid Motion 
Graphics server. Since the output is DVI, you may need an adapter for your VGA monitor.  

When installed in a rack with several servers an optional KVM switch can also be used. Avid recommends 
the Avocent KVM model HMX 2050. The keyboard and mouse connections use the same type of USB 
ports. Follow the instructions supplied with your KVM switch. You need to supply KVM cables that are 
compatible with your KVM switch. 

Note: There are four USB ports on the rear of the Avid Motion Graphics server. Two of the ports are 
used for the application keys. When you purchase your KVM switch, make sure it includes a USB 
splitter cable so that both your keyboard and mouse can plug into the splitter cable and use a single 
USB port on the server. 

http://support.microsoft.com/kb/2584454
https://www-304.ibm.com/support/docview.wss?uid=swg21367951
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FastAction Keyboard (FAK) 
The FastAction keyboard is an optional keyboard that has many additional function keys for direct access 
to Deko functions. Proper functioning of the FastAction Keyboard requires a supplied special driver which 
is optionally installed as part of the Deko custom installation. The FastAction Keyboard firmware must be 
version 1.6 or later. The firmware version is displayed in the FastAction Keyboard's display when power is 
first applied. 

Installation Information 

Avid Motion Graphics v2.5.1 and v1.2.1 Running on a Single Avid Motion Graphics 
Server 

Avid supports both Avid Motion Graphics v1.2.1 and Avid Motion Graphics v2.5.1 applications installed on 
a single Avid Motion Graphics hardware device.  

• Avid Motion Graphics v1.2.1 runs Deko Version 6.2.2 as the user interface.  
• Avid Motion Graphics v2.5 and later uses the Avid Motion Graphics user interface.  

You can run either one, but you cannot run both applications simultaneously. You can also use the 
DekoPlayer component to make use of Deko files within the Avid Motion Graphics v2.5 or later user 
interface.  

See the Avid Motion Graphics User’s Guide for more information about DekoPlayer. 

The licensing for Avid Motion Graphics is shared by both applications from v1.2 going forward. You are 
licensed for either Avid Motion Graphics or Avid Motion Graphics Production. If you are licensed for Avid 
Motion Graphics v2.5 or later, your Avid Motion Graphics v1.2.1 runs the Deko 3000 user interface and 
functionality. If you are licensed for Avid Motion Graphics Production, your Avid Motion Graphics v1.2.1 
runs the Deko 1000 user interface and functionality.  

Avid Motion Graphics v1.2.1 does not require the licensing dongle and HASP dongle that were required in 
Avid Motion Graphics v1.0.  

Remove the licensing dongle and HASP prior to upgrading the software.  

You may install Avid Motion Graphics v1.2.1 on a computer that already has Avid Motion Graphics v2.5 
installed and licensed, or vice versa.  

Upgrading from Avid Motion Graphics v1.0 to v1.2 or Later 

This topic contains information on how to upgrade your Avid Motion Graphics software from v1.0 to v1.2 
or later.  

AMG licensing has been improved since version 1.0, and no longer requires licensing dongles or HASP 
dongles.  Prior to upgrading you will need a new software license to enable the same functionality.  Contact 
Avid Sales or Customer Support to obtain the new licenses.   

Important: You must have the AMG system drive image Rev.3 before upgrading your system.    

3. Contact Customer Success and have them open an individual case in Salesforce for each system 
you are upgrading. 

When opening the case, the Customer Service Representative will need the Activation Card System 
ID. 

4. For each system you are upgrading, confirm the Windows image version by looking at the 
image.txt file. This can be done by navigating to C:\image.txt.  
 
If the image version (shown at the top of the text file) is v1.0 or v2.0, and displays Rev.1 or Rev.2, 
you must reimage the system.  
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5. Contact Avid Customer Success for an updated image prior to installing the new AMG software.  
Prior to re-imaging your system, Avid recommends that you backup the following: 

o AMG Deko Preferences 

o IP Settings 

o Fonts Folder 

o ODBC Settings 

o Clip Import Settings 

o Macro Server Settings 

o 3rd Party Software Configurations and settings such as: 

 Peer Sync 

 War FTP 

6. To reimage your system, you need a v3.0 or later Image USB Drive. To obtain the v3.0 Image 
USB drive, contact Customer Success.  
 
For more information on reimaging, see Chapter 10 “product Recovery” of the Avid Motion 
Graphics Setup and Configuration Guide. 
Note:  If the site is integrated with a Command / Deko Select solution, you should backup 
those settings by opening the Configuration menu, and using the Snap utility to capture screen 
shots of each submenu. 

Avid Motion Graphics Server Installation and Configuration Documentation 
Important Avid Motion Graphics setup and configuration information is found in Chapter 3 “Software 
Installation” of the Avid Motion Graphics Setup and Configuration Guide v2.5 with the installation files, on 
the installation USB device. This guide can be found online in the Avid Knowledge Base. 

Starting the Application after Installing the Software 
If you encounter an error when starting the Avid Motion Graphics application for the first time, close the 
error message and change the display resolution frequency to 60Hz. For further information, contact Avid 
Customer Success. 

New Features  
The following new features were added. 

New Features for AMG v1.2.1 (Deko 6.2.2) 

UDevC00178365. Added Ability to Set the Hardware Vertical Offset Timing from Deko 
You can now set the hardware vertical offset timing from Deko version 6.2.2. See Options/Hardware 
Settings/Output V timing. Previously it was only possible to set the horizontal offset timing. 
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Software Changes  
The following software changes were made. 

Software Changes for AMG v1.2.1 (Deko 6.2.2) 

UDevC00178883. Clips and Video Input No Longer Displays “Jaggy” Edges” in Video Output 
In Deko 3000 and Deko1000 version 6.2.1, but not in versions previous to that, clips and video input were 
sometimes showing up on video output with jaggy edges (aliasing). You could especially see it in graphic 
content in the clip or video input.  This was happening in all interleaved video standard - that is, everything 
except the 720P standards. This issue has been fixed. 

UDevC00178317. Audio No Longer gets Dropped at the Start of a Clip 
In Deko version 6.2.1, audio at the very start of a clip was getting dropped. This issue has been fixed. 

UDevC00178352.  ipf.exe No Longer Randomly Crashes 
The cause of a potential random crash of ipf.exe was discovered, and has been fixed in Deko version 6.2.2. 

UDevC00178245. Pause on Reveal Effects No Longer Cause Previous Text to Disappear 
In previous releases of Deko3000 and Deko1000 versions 6.0 through 6.2.1, a Pause on a Reveal effect 
would cause the previous text in video output to disappear when the effect went into pause. This issue has 
been fixed. 

UDevC00179024. Deko Log Now Shows Layer Substitutions Done Through Automation 
The Deko log will now show layer substitutions done through automation (e.g. Command) when verbose 
logging is turned on. 

UDevC00178416. Deko Log Entries No Longer Get Cut Off Due to Unicode Characters 
Deko log entries were getting cut off when Unicode characters were in the log message. This issue has been 
fixed. 

UDevC00178273. Ipf.exe No Longer Crashes When Running Deko Before Activating Your License 
In Deko version 6.2.1, if you tried to run Deko before activating your license, there was a crash in ipf.exe. 
This issue has been fixed. 

Software Changes for AMG v1.2 

UDevC00162285. HD Output No Longer Stops Playing 
In Deko 6.0 and Deko 6.1, connecting an SD input while playing out in HD would cause the HD output to 
stop playing. That has been fixed. 

UDevC00169722. Dragging Clips into ClipEditor Now Includes Clip File Name in Error Message 
In previous versions of Deko, when the user dragged a clip (as opposed to double-clicking it) in the 
ClipEditor, and the load failed, the error message did not include the clip file name. The error message now 
includes the clip file name. 
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UDevC00173515. Deko No Longer Renders Arabic Incorrectly When Hamza Character is Typed 
The Hamza character in Arabic was causing incorrect rendering of the previous (to the right) character. The 
previous character would be rendered as a medial character, when it should be rendered as a final character. 
That has been fixed in this version of DekoSelect.  

Note: In order to play out correctly on a Deko, you will need a version of Deko that also contains this fix. 
That fix will appear in Deko 3000, Deko 1000 and Deko 550 version 5.3.6 and PostDeko version 8.3.6. It 
will also appear in Deko 3000 and Deko 1000 version 6.1.1. 

UDevC00175513. Layer Browser View Resource Leak Fixed 
After you opened a Layer Browser view, there was a resource leak that would eventually lead to the error 
“Required resource was unavailable” and Deko would no longer function and would need to be stopped. 
That has been fixed. 

UDevC00177425. Fixed Crash Due to Graphics or Custom Typefaces on Mapped or Network Drive 
There was a potential crash that could occur when graphics or custom typeface paths were on a mapped or 
network drive - either when shutting down or changing drives. That has been fixed. 

UDevC00177740. Background Clips No Longer Disappear During Effect Playback 
Under certain circumstances, background clips were disappearing during effect playback in Deko 6.0 and 
Deko 6.1. This has been fixed. 

UDevC00177829. Now Showing Better Error Information in Log When Macro Fails 
The macro error information in the Deko log was not always listing the command and parameter that failed, 
even when it was available. Now it does. 

UDevC00177838. File > Save Motion As Entry in Motion View Fixed 
In some previous versions, the menu entry for File / Save Motion As had unexpected characters in it. That 
has been fixed. 

UDevC00177841. Clip Status in Clip Editor No Longer Flashes When Value Not Changing 
In the Clip Editor, the clip status was constantly flashing, even though its value wasn't changing. That has 
been fixed. 

Software Changes for AMG v1.1 

Initialization and Shutdown 
In Avid Motion Graphics v1.0, there were intermittent crashes in ipf.exe when shutting down Deko. This is 
fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0 there was an intermittent crash of ipf.exe during Deko startup. This is fixed 
in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0, there was sometimes and audio noise on start up. This is fixed in Avid 
Motion Graphics v1.1.  

Performance 
In Avid Motion Graphics v1.0, turning on video input was sometimes causing stuttering on output. This is 
fixed in Avid Motion Graphics v1.1. 

Log messages related to the AMG engine used by Deko can now be found at 
c:\programdata\Avid\Support\Logs\AMG 
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Clips 
In Avid Motion Graphics v1.0, when trying to load a clip with an apostrophe in the folder name or clip 
name, the application would freeze, and then the engine would fail. This is fixed. Now, when loading a clip 
with an apostrophe in the folder name or clip name, the application does not freeze nor does the engine fail. 

In Avid Motion Graphics v1.0, when running in NTSC, a motion on a 480-line clip was displaced by 6 
lines, and top of the clip would wrap around to the bottom. This is fixed. Now, when running in NTSC, a 
motion on a 480-line clip is no longer displaced nor does the top of the clip wrap around to the bottom. 

In Avid Motion Graphics v1.0, a motion playing on a clip from Preview might not cause the clip to appear, 
if there was no play-off action for the clip that was in Program. This is fixed. Now, a motion playing on a 
clip from Preview causes the clip to appear, as expected even when there is no play-off action for the clip in 
Program. 

In Avid Motion Graphics v1.0, the video output flashed when loading a new clip after having disabled clip 
output with the "Bgd Clip" button while a clip was playing. This is fixed. Now, video output no longer 
flashes when loading a new clip after having disabled clip output with the "Bgd Clip" button while a clip is 
playing. 

In Avid Motion Graphics v1.0, when a graphic had more than one clip, after cancelling a motion or effect 
on it, and playing it again, one of the clips might not play. This is fixed. Now, when a graphic has more 
than one clip, after cancelling a motion or effect on it, and playing it again, the clips play as expected. 

In Avid Motion Graphics v1.0, after playing an effect or motion involving background clips in both 
Preview and Program, if you played the effect again, sometimes the program clip would stay on the output 
until the effect completed. This is fixed. Now, after playing an effect or motion involving background clips 
in both Preview and Program, and if you play the effect again, the program clip no longer stays on the 
output until the effect is completed. 

In Avid Motion Graphics v1.0, when you turned off clip output by toggling the "Bgd Clip" button, if the 
currently playing clip had audio, you would continue to hear the audio, even though the clip no longer 
showed. This is fixed. Now, when you turn off clip output by toggling the "Bgd Clip" button, if playing clip 
has audio, you no longer continue to hear the audio. 

In Avid Motion Graphics v1.0, when a clip had a key that was longer (more frames) than the fill and it was 
set to loop, the key would move out of sync with the clip after each time through the loop. This is fixed. 
Now, when a clip has a key that is longer (more frames) than the fill and it is set to loop, the key stays in 
sync with the clip after each time through the loop. 

In Avid Motion Graphics v1.0, the audio volume of a clip ramped up and down while it was dissolving in 
or out. This is changed, since that was not the behavior in previous versions of Deko. Now, the audio 
volume is at full level as a clip dissolves in, and while it dissolves out, until it becomes invisible. 

In Avid Motion Graphics v1.0, after playing a non-looped clip in the Clip Editor, the clip would sometimes 
not play again until you dragged it back to the beginning of the clip. This is fixed. Now, when you play a 
non-looped clip in the Clip editor, it plays as expected. 

In Avid Motion Graphics v1.0, when playing multiple clips with audio, if there was a time gap of 15 or 
more minutes between playback of clips with audio, the audio  of all subsequent clips was delayed by 2 
seconds. This is fixed in Avid Motion Graphics v1.1.  

In Avid Motion Graphics v1.0when the user sets a Mark In point for a clip, the timecode button would 
intermittently be off   by one frame. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0after linking a mask to a clip, sometimes the mask would not take effect 
immediately on video output. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0 clip layers in the Preview video (HDMI) output sometimes did not match the 
correct clip layers that were being shown on the desktop preview view. This is fixed in Avid Motion 
Graphics v1.1. 
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In Avid Motion Graphics v1.0, the video output feedback while scrubbing a clip was not very responsive. 
This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0, when you played a clip with audio, stopped it, and restarted it, the audio 
could get out of sync with the video. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0 Make Deko Movie in NTSC was sometimes resulting in a frame-reversed 
clip. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0, if a sequence contained an event with two clip layers, and the next on 
contained a background clip, there was a possibility of ending up with too many clips playing, and the 
background clip playing very slowly. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0, if you played a clip with audio, waited over 20 minutes, and then played a 
clip again, the audio would be out of sync with the video. This is fixed in Avid Motion Graphics v1.1. 

In Avid Motion Graphics v1.0 if you read in a graphic with a clip layer to both Preview and program and 
did a dissolve effect, the clip layer would go black and then pop back on. This is fixed in Avid Motion 
Graphics v1.1.  Now, it just keeps playing as was intended. 

In previous versions of Deko, when the user dragged a clip (as opposed to double-clicking it) in the 
ClipEditor, and the load failed, the error message did not include the clip file name.  This is fixed in Avid 
Motion Graphics v1.1. The error message now includes the clip file name.  

In Avid Motion Graphics v1.0, when a clip layer was being replaced by another clip layer, there was 
sometimes a flash in the original clip layer. This is fixed in Avid Motion Graphics v1.1. 

Motions and Effects 
In Avid Motion Graphics v1.0, the preview HDMI output failed to update after certain DVE effects: Folds, 
Page Turn, Cylinder, Page, Scroll. This is fixed. Now, preview HDMI output updates after those DVE 
effects. 

In previous versions, a very long roll effect could cause deko to run out of memory and cause subsequent 
problems. That situation is now being detected, and an error message is put out instead of attempting to 
play the roll.  

In AMG 1.0, Audio in Deko motions (.mot files) were playing late by as much as 2 seconds in certain 
circumstances. This has been fixed in AMG v1.1. 

In AMG 1.0 there was a performance issue where frames were sometimes dropped from video input. This 
has been fixed in AMG v1.1. 

In some previous versions of Deko, the Reveal effect was playing back twice as fast as it should have. This 
has been fixed in AMG v1.1.  

III Automation using Unicode 
In Avid Motion Graphics v1.0, III automation with "CMD In Unicode" turned on, did not work as 
expected. Chyron key codes are supposed to be offset by 0xE000 when doing the Unicode protocol. But the 
Chyron newline key (206,0xCE) was not recognized by the offset value in some circumstances. And the 
numpad keys (192-201, 0xC0-0xC9) were only being recognized by their original values. This is fixed. 
Now, the code always recognizes the offset codes when running in III Unicode. 

The code now always recognizes the offset codes when running in III Unicode. If you want to use 192-201 
and 206 to represent Unicode characters, there are new settings to use so they will not be recognized as 
Chyron keys. To use these settings, submit the macro command line: 

@settings:iii_newline_unicode = 1; @settings:iii_numpad_unicode=1  

If Automation is currently enabled, turn it off and then on again.  Select Options > Save Settings Now, 
you'll be able to use all Unicode characters as expected. 
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All Other Changes 
In AMG 1.0, when running in PAL or 1080i video standards, the Channel/Frame Grab function was 
producing a jaggy (field-reversed) frame. That has been fixed.  

In AMG 1.0, with UAC on, double clicking on .dko files in Windows Explorer would not start Deko 
because the Deko file types were not being properly registered. This has been fixed in AMG v1.1. 

When opening a graphic that refers to a texture that is not found, the Texture File Name was getting 
changed to blank for all subsequent references to that texture in that graphic. This has been fixed in AMG 
v1.1. 

In AMG 1.0 with UAC on, double clicking on a .dko file in Windows Explorer when Deko is running 
would not open the .dko file. This has been fixed in AMG v1.1. 

Starting in Deko 5.3, Deko would crash if you were running with the Preference for Keyboard/Enhance 
Keypad, and entered a non-existent graphic through the keyboard number keypad when in the Graphic 
Browser. This has been fixed in AMG v1.1. 

If you installed the FAK (Fast Action Keyboard) driver that was distributed with AMG 1.0, Deko could 
crash if you tried to change the keyboard in the Style view/Font tab, or if you read in a graphic that was 
tired to a different keyboard (Such as French or German). Deko has been fixed so that it will not crash in 
this circumstance. And the FAK installer has been fixed so that it will load foreign keyboards successfully. 

In AMG 1.0, a Frame Grab would sometimes cause the program to hang the first time it was done after 
changing the video standard. This has been fixed in AMG v1.1. 

The menu entries for Color Bars and Show Key Output are no longer in the Edit and Layer menus. They 
appeared there in error in the 6.0 release. That was preventing Alt E C from going to the Copy menu when 
in Preview or Program. 

Software Changes For Deko v6.0 

Reference Source Option 
In previous versions, there was no Reference Source option available in the Hardware Settings dialog box. 
This is changed. Now, in the Hardware Settings dialog box, there is a Reference Source option to designate 
the source of reference signal. 

 

VideoIn Signal Freezes 
In previous versions, if a user disconnected the VideoIn cable while Output was playing the VideoIn just 
went away. In Deko 6.0, if a user disconnects the VideoIn cable while the output is playing, the VideoIn 
signal will freeze. 
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User Interface Does Not Flash 
In previous versions, the user interface would flash when the clock was running in a layer.  In Deko v6.0, 
the user interface does not flash. 

Visible, Moving Transition Point 
In previous versions, when doing a Push or Wipe, you didn't see the transition point moving. This is 
changed in Deko v6.0. Now, when doing a Push or Wipe, you will see a visible, moving transition point. 

Auto-Pause 
In previous versions of Deko, when an element should have been off-screen at the end of the play-off 
actions and if the "clip layer" was not off-screen, Deko did not add an auto pause. This is changed. Now, 
when an element should be off-screen at the end of the play-off actions and if the "clip layer" is not off-
screen Deko adds an auto-pause. 

Log Files Pre-pended 
In previous versions, the Deko log files were not pre-pended with the Windows user ID. This is changed. 
Now, Deko log files are pre-pended with the Windows user ID. 

All Files are Transcoded  
In previous versions, some formats were imported directly. This is changed. Now, all files except .mxf files 
are transcoded during the import process. 

Open and Save Dialog Boxes 
In previous versions, Windows XP Open and Save dialog boxes were used. Deko v6.0 uses Windows 7 file 
Open and Save dialog boxes. 

init.mcr file  
In previous versions of Deko, the init.mcr file, which launches the Macroserver automatically after starting 
Avid Motion Graphics, was located in the Install directory. This is changed. Now, the init.mcr file is 
located in the following directory, which is created the first time you run Deko: 
c:\users\public\documents\avid\deko\CommonMacros directory  

"Sequence"-"Show Full Pathnames" Option 
In previous versions, changes to the "sequence" - " Show Full Pathnames" option were not retained when 
the user saved settings.  This is fixed with Deko v6.0. 

Unresponsive Application 
In previous versions, the application would intermittently become unresponsive when looping CAP Shader 
events.  This is now fixed. 

Frame Grab  
In previous versions, Frame Grab was used to grab frames from clips located in the clips database. This is 
changed. Now, Frame Grab is used only to grab frames from VideoIn. 
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Known Limitations 
This section provides information on known limitations that were not addressed in this release. Any 
available workaround procedures are also documented, when possible. 

Note: For limitations related to compatibility of this release with previous versions/other products, 
see the section of this document entitled, Compatibility Notes. 

New Known Limitations for v1.2 

Deko v 6.2 

UDevC00177588. Video Input Shows Poorly on Video Output if Connected After Starting 
Deko 
If you are going to be using video input, the cable needs to be connected when you start up Deko. If you 
connect it after starting up Deko, the video input will not appear correctly on video output. 

UDevC00177698. Clip Movement When Loading a Clip into Program and End of Playback 

In the clip editor, when you double-click on a clip to load it into Program, you might see some movement 
in the video output, seeing the second frame or field briefly before seeing the first. Also, when a clip plays 
all the way to the end, it might briefly go back and forth between two different end frames. 

UDevC00177424. Clip Scrub and Play to End Issues 

In the Clip Editor, if you play or scrub a clip all the way to its end point, the following happens: 

• The Clip Editor button to go back one frame does not work 
• The Clip Editor button to go back to the beginning of the clip does not work. 

Workaround: Drag the clip back one frame from the end, and then those buttons will work again. 

Known Limitations for v1.1 

Deko v 6.1 

Clip Import 
In Clip Import, the MXF File Compression Format Bitrate is now limited to a value that will help assure 
real time playback. 

Output View 
There is an Output view available on the desktop that is a copy of exactly what goes out to video output. It 
is there as a convenience for graphic creation and diagnostics. It is not meant to be used during on-air 
playout, because it causes an extra processing burden on the video output engine. It can no longer be turned 
on in the View menu. To turn it on for off-air use, submit the command “view_show opengl” on the 
command line. 

 Deko File Open Dialog Box 
On the File Open Dialog box, when a file is selected using the drop-down box for recently used files, the 
fields containing information related to the graphic file (Comments, Video Format, Image Properties) do 
not update dynamically. 

Workaround: If the user needs access to the file information, select the file using the file name menu, 
which is the pane in the open dialog box that contains the list of file names. 
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Deko VideoIn Preview 
The Avid Motion Graphics Server v1.1 does not support the Deko Preview for VideoIn. Deko VideoIn is 
now displayed in the Program view. 

Files Missing a Component 
When you open a Deko file with a missing component, you are prompted to browse for the missing 
component. After browsing to the folder which contains this missing component, the file isn't highlighted 
and displayed in the file list screen by default. 

Workaround: You may need to use the vertical scroll bar to find the missing component. 

Changing Spell Check Language 
To change the spell check language in Deko v6.1, the user must run Deko as an Administrator. 

Workaround: When prompted, log on as a Deko Administrator to be able to change the spell check 
language. 

Field Markers are Wrong Size 
Field Markers are the wrong size after effect (or sequence) playback. Currently, there is no workaround for 
this issue. 

No preview Frame Available for Import 
Cannot preview the first or middle or end frame of VBS and M2V files in the import clip window on HD 
video format. Currently, there is no workaround for this issue. 

Key Offset 
The key offset functionality in the Clip Edit window isn't supported in Deko v6.1.  

Clock Skips during Playback 
When playing a clock and showing tenths of seconds, you'll see the clock skip tenths of seconds during 
playback. Currently, there is no workaround for this issue. 

ClipAutoUpdate Automatically Run After Login Option  
The Automatically run after login option, does not work unless you run ClipAutoUpdate as an 
Administrator. 

Workaround: Run ClipAutoUpdate as administrator, and then enable the 'Automatically run after login' 
option. 

nVidia Power Settings 
In the rare case of a server failure, when the Windows OS restarts, the nVidia power setting may get reset 
to the incorrect setting, which can cause intermittent stuttering during playback. 

Workaround:  If the server encounters a failure resulting in a Blue Screen error and restarts, verify the 
power management mode is set to 'Prefer maximum performance' in the nVidia Control Panel. 

Instructions:  

1.  Right click on desktop 

2.  Go to nVidia Control Panel 

3.  In the left column, Manage 3D settings must be selected. 

4.  On the right side, on the Global Settings tab, ensure the Global presets setting is set to 'Base profile'. 

5.  Look for 'Power management mode' in the list of settings.  This value must be set to Prefer maximum 
performance. 
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Note:  If the value is set to Adaptive, change it to Prefer maximum performance and click Apply. 

Formats Other Than NTSC 
In Deko v6.1 all formats other than NTSC must start with the 'Top Field First'.  

Video Out White Screen 
When doing a power cycle restart of the Deko server using NTSC or PAL SD format, intermittently, the 
video out will flash a white screen. Currently, there is no workaround for this issue. It autocorrects itself 
and does not affect playback. 

Fill Type and Source Changes  
In the 'Fill type' and 'Source' in the clip edit window, Unshaped 0-255 and Shaped 0-255 are not supported 
in this version.  You may specify Unshaped 16-235 or Shaped 16-235.  

Video Output Not Cleared After Stopping a Crawl Effect 
“Stopping a crawl effect does not clear the video output.  Use “Clear Program” if desired.   

Supported Audio Bit Rate 
This version only supports 16 bit Audio. If a user hears noise or a lack of audio all together, the bit rate 
used might be incorrect. 

Workaround: Ensure the audio used is 16 bit. 

iNEWS Command 

Pauses 
When using Deko v6.1 with iNEWS Command, pauses aren't always honored if the Command 
Deko Device service is configured for Single channel instead of Dual Program mode in the Avid 
Service Framework, Service Configuration application. 

Workaround: Always set the Command Deko Device service to Dual Program mode in the Avid 
Service Framework, Service Configuration application. 

Playing Back Graphics 
When playing back graphics via iNEWS Command, the file name on title bar of motion does not 
update even though actions change to the new motion.  The motion plays correctly; it’s just the 
incorrect label in the title bar 

Channel Designation 
The Avid Motion Graphics Server is a single channel configuration. If something comes into a sequence 
with a Channel B designation, it is played on Channel A because this system is only a single channel 
configuration. 
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Technical Support Information 
Most products feature a number of coverage options. Avid Assurance service offerings are designed to 
facilitate your use of Avid solutions. Service options include extended telephone coverage, automatic 
software maintenance, extended hardware warranty, and preferred pricing on replacement parts. Offerings 
and options may vary by product and are not available for all products. 

For more information regarding Avid service offerings, visit www.avid.com/support or call Avid Sales at 
800-949-AVID (800-949-2843). 

Program availability and details might vary depending on geographic location and are subject to change 
without notice. Contact your local Avid office or your local Avid Reseller for complete program 
information and pricing. However, if you need help locating an Avid office or Avid Reseller near you, 
please visit www.avid.com or call in North America 800-949-AVID (800-949-2843). International users 
call 978-275-2480. 

Accessing Online Support 
Avid Online Support is available 24 hours per day, 7 days per week. Search the Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to read/join 
online message-board discussions. 

To access Avid Online Support: 

 Go to www.avid.com/Support. 

Note: Supplemental documentation for this release, if available, is provided on the Knowledge Base. 
For the latest up-to-date information, browse the Knowledge Base at Avid Online Support. 

http://www.avid.com/support
http://www.avid.com/
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Copyright and Disclaimer 

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc. 

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by visiting Avid's Web site at 

www.avid.com. The terms of that license are also available in the product in the same directory as the software. The software may not be reverse 

assembled and may be used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any 

medium except as specifically allowed in the license agreement. 

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and 

recording, for any purpose without the express written permission of Avid Technology, Inc. 

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents. 

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved. 

Attn. Government User(s). Restricted Rights Legend 

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer 

software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all 

rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS 

§227.7202-1(a), as applicable. 

Trademarks 

Adrenaline, AirSpeed, ALEX, Alienbrain, Archive, Archive II, Assistant Avid, Avid Motion Graphics, Avid Unity, Avid Unity ISIS, Avid VideoRAID, 

CaptureManager, CountDown, Deko, DekoCast, FastBreak, Flexevent, FXDeko, iNEWS, iNEWS Assign, iNEWS ControlAir, Instinct, IntelliRender, 

Intelli-Sat, Intelli-sat Broadcasting Recording Manager, Interplay, ISIS, IsoSync, LaunchPad, LeaderPlus, ListSync, MachineControl, make manage 

move | media, Media Composer, NewsCutter, NewsView, OMF, OMF Interchange, Open Media Framework, Open Media Management, SIDON, 

SimulPlay, SimulRecord, SPACE, SPACEShift, Sundance Digital, Sundance, Symphony, Thunder, Titansync, Titan, UnityRAID, Video the Web Way, 

VideoRAID, VideoSPACE, VideoSpin, and Xdeck are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or 

other countries. 

All other trademarks contained herein are the property of their respective owners. 
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• This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form. 
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